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1.1 Introduction
The Digico SD10 consists of a worksurface with an onboard audio engine and a range of onboard inputs and outputs. This can be
connected to multiple Input/Output Rack Units by MADI links or optical fibre (optionally) which carry all the audio input and output
signals.

The console worksurface consists of 3 sections that can control 96 input channels (12 of which can be stereo with no loss of
channel count), 24 VCAs, up to 48 aux/group busses (plus Master buss configurable as LCR, and solo buss), a matrix of 16
inputs and 16 outputs, 24 onboard graphic EQs and 16 onboard stereo effects.
The left section has 12 assignable faders and 12 sets of assignable encoders and switches.
The centre section has, a touchscreen, 12 assigned encoders, 12 assignable faders, 12 sets of assignable encoders and
switches, a full set of channel processing controls and a master fader.
The right section has 12 assignable faders, 12 sets of assignable encoders and switches and controls for monitoring, head-
phones, talkback, macros and snapshots.
Any of these worksurface sections can be assigned to the centre touchscreen.

Multiple console setups can provide:
Front of House and Monitoring with shared stage racks and gain tracking.
Remote control of a console from a laptop computer.

Optional extras include Waves plug-ins, Broadcast mode (Broadcast mode includes features such as surround busses, mix minus
busses, multi-input channels, backstop PFL, auto PFL, fader start GPOs and expanded monitoring options) and Theatre Mode. See
the Appendices for details of these options.

1.2 Manual Overview
This manual provides an overview of the desk, and describes some of the basic operating principles which the user will need to
understand in order to run the desk.

For full details on all SD software functionality please refer to the SD Series Software Reference Manual available for download
at www.digico.biz

The following typographical convention used in this manual: An arrow bracket (>) is used to indicate a sequence of button
pressing.
For example, Layout > Fader Banks indicates that the Fader Banks button is accessed by first pressing the Layout button.
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1.3 Before You Start
There are certain general operating principles and terms that should be understood before continuing to use this manual.
Please read this chapter carefully before proceeding.

1.3.1 Worksurface Layout..............................................................
Centre Section

Input Gain and Phase

Assignable Rotaries and Switches
Aux / Pan / Dynamics/FX Controls

Mute and Channel Select Buttons

Channel Faders

ALT Input Switch

Undo/Redo
2nd Function Button
Option/All Button

USB PortLight
Controls

Assignable Rotary Scrollers

Channel Processing:
High and Low Pass Filters
4 Band Dynamic Parametric EQ
Dynamics Thresholds & On / Off
Channel Inserts A & B On/Off
Direct Out On/Off
Joystick Panning

Touch/Turn Controls

Touchscreen

Left/Right/Master Screen Assign

Snapshot Previous/Next
Centre Section Screen Assign

Bank Select Buttons
& Master Fader/Mute

Left Section (Optional - not on SD10 24)

Laptop Area for Optional
Remote Control

Assignable Rotaries and Switches
Aux / Pan / Dynamics Controls

Mute and Channel Select Buttons

Channel Faders

Left Section Screen Assign

Bank Select Buttons
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Right Section

Assignable Rotaries and Switches
Aux / Pan / Dynamics Controls

Macros

Space for Keyboard 
& Trackball

Snapshot Automation

Channel Faders

Right Section Screen Assign

Talkback

Monitoring

Bank Select Buttons

Mute and Channel Select Buttons

Smart Keys

1.3.2 Screen Assignment ...............................................................
The SD10 touchscreen is used to access many of the console's functions.
There are 4 possible views that can be seen on this screen - Left section - Centre section - Right section - Master screen
Each console worksurface section has its own Screen Assign button which, when pressed, will allow the channels in that
section to be viewed on the screen and controlled by the Centre section's Channel Processing controls such as EQ and Dynam-
ics. When the button is lit, that section is assigned to the screen.
When a section has been assigned to the screen all of the controls in the upper centre section are also assigned.

The Left and Right worksurface sections also each have a button labelled Assign To Centre which will allow all of the Centre
sections controls including faders, mutes and solos to control the bank which has been selected in the Left or Right sections..

There are also additional buttons in the centre section which can assign the Left and Right sections to the screen and a Master
button which allows you to view the Master screen. The Master screen gives access to many setup and other functions which
are not directly related to the console's channels.
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1.3.3 Layers and Banks .................................................................
The SD10's worksurface is divided into Layers and Banks. Each Bank contains twelve channels, and the channels which are
currently active on the control surface are defined using the fader bank and bank layer buttons to the right of the Channel Strip
section’s faders:

Select a Layer

Select a Bank

A ‘bank’ is a set of twelve faders, and a ‘layer’ contains up to four ‘banks’. There are two ‘layers’ in each section of the desk,
allowing up to 288 channels to be accessible on the worksurface.

Pressing the bank layer button, located above the fader bank buttons, toggles between layers.

To access a bank of faders within that layer, press the appropriate fader bank button. To switch all three sections of the
console to the same bank level, press and hold one of the fader bank buttons.

The position of the banks on the worksurface is defined in the Layout > Fader Banks panel. By default, the Input channels will
be assigned to Layer 1 on the left and right sections of the console. The different output channels will be assigned to Layer 1 on
centre section. Control Groups will also be assigned to the centre section. These bank assignments can be customised by the
user and saved in a session at any time.

1.3.4 Using the Control Surface ....................................................
There are two main ways in which all of the functions of the SD10 are accessed:

1. The touchscreen display, which can be controlled directly using a finger, or by using the keyboard and mouse
2. The physical encoders, switches and faders.

Note that when touching the screen directly, you may find it easier to use a finer point than your finger.
However, in order to prevent damage to the screen, it is important that you only use devices specifically
designed for touching screens (such as a pda stylus), and that you never press down hard on the screen.

A number of functions can be accessed in different ways, allowing users to operate the console using whichever interface they
prefer. This manual will describe accessing on-screen functions by touching the screen directly and not by using the mouse.

All of the physical controls found in the centre section are described in full within the relevant section of the manual and many
require no further introduction. The Master screen has a row of grey buttons which are used to access a range of configuration
displays. Pressing these buttons opens either a further drop-down sub-menu or a pop-up display. If a drop-down menu is
opened, pressing on one of its entries will open a pop-up display. The buttons lighten to indicate that their sub-menu or pop-up
display is open. A number of the buttons within each pop-up display generate further pop-ups.

The buttons within the pop-ups are coloured grey when their function is inactive, generally switching to a lighter shade of the
pop-up background when their function is active. Pressing on a text box opens a numeric or QWERTY keypad which can be
operated directly by pressing the screen or via the console’s external keyboard.

Pop-ups are closed by pressing the box in the top right-hand corner of the pop-up, marked CLOSE or CANCEL (or by pressing
CAN on keypad pop-ups).

To the right and below the Master screen is a single encoder marked touch-n-turn (shown below). This is used to access some
of the rotary and switch controls within the Master screen. To assign the touch-n-turn encoder to a particular on-screen pot,
touch the pot to be assigned. You will notice that a coloured ring appears around the on-screen pot, indicating that it is assigned
to the touch-n-turn encoder/switch.
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1.3.5 The Assigned Channel .........................................................
One of the channels in the Channel Strip panel is displayed in gold, indicating that it is currently the Assigned Channel. This means
that it has been assigned to the worksurface controls and can be configured in detail, as described below. To Assign a channel,
touch anywhere in the channel on the screen (except the Aux Send area).

Once a channel is Assigned, all of the controls for that channel which are not displayed within the channel strip itself can be
accessed via secondary pop-ups, displayed by touching inside the relevant area of the channel. These pop-ups include controls
such as input and output routing and signal processing parameters.
A number of the physical rotary encoders on the control surface can be assigned to different on-screen pots. In order to ensure
that it is clear which function is assigned to which encoder, the assigned on-screen pot will have a coloured ring around it.

The twelve encoders and buttons immediately above the touchscreen refer to the channels with which they are aligned. These
controls are concerned with the channel input, located at the top of the Channel Strip panel.

The three rows of encoders and buttons immediately below the touchscreen also refer to the channels with which they are
aligned. Normally, the upper two rows control the level and on/off status of the two highlighted aux sends, but can have a number
of functions assigned to them. Touching on an aux send on the screen will assign that aux and the ones immediately below it to
the aux encoders. Six of the aux sends can be displayed in the Channel Strip panel at any one time. If more than six aux sends
have been created in the session, the scroll buttons outside the bottom left-hand corner of the screen can be used to scroll the
display through the remaining auxiliaries. The third row is assigned to channel pan by default.

The controls to the right of the Channel Strip panel allow the Assigned channel to be adjusted:

1.3.6 The Master Fader ..................................................................
By default, the master fader is assigned to the master group output, which is the lowest stereo group output by default. In
addition, the master fader can be assigned to the solo buss output.
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1.3.7 Other Centre Section Controls .............................................
To the left of the Channel Strip panel are more channel controls: When pressed, the 2nd function button allows access to
different parameters:

1) Stereo Aux Pan and Pre/Post switching
2) Hard Mute of a channel
3) Fine adjustment of Delay settings on output channels

The Option/All button has 2 main functions:
1) When pressed and released, any channel that is a member of a gang will be temporarily isolated from that gang.
2) When pressed and held, any parameter that is adjusted on a single channel will also be adjusted in the same way

on all of the channels in that bank

1.3.8 Channel Types ......................................................................
The signal flow of the SD10 is best understood in terms of the four channel types contained within it, shown below. Each channel
type offers full signal processing capabilities. As a summary, the four channel types are as follows:

- Input channels bring signals into the console to be mixed and sent to aux and group busses.
- Aux channels send a variety of mixes of the Input channels to the Aux outputs, mainly for use as monitor mixes and FX

sends.
- Group channels mix groups of input channels together, to feed the buss outputs or the output matrix.
- Matrix channels send the outputs of the matrix to the console’s main outputs (Optionally).

The Group channels, Aux channels and Matrix channels are all referred to as output channels. While the Aux and Matrix channels
are the channel types most commonly routed to outputs, all four channel types can be routed directly to outputs.

Input Module - Touch to Expand 
Analogue Gain/Digital Trim

Phase - Gain Tracking
Main/Alt Input Select

Inputs

Insert A Routing & On/Off

HPF/LPF

4 Band Dynamic EQ
Touch To Expand

Multiband Dynamics
Touch To Expand

Insert B Routing & On/Off

Aux Sends
Touch to Assign Rows

Channel Pan
Mute Indicators

Channel Label
Routing Module - Touch to Expand

Gang & Safe Indicators

Groups Auxes Matrix

Channels are laid out in banks of 12 on the console worksurface and can be identified by their colour: Light-blue for Input chan-
nels, red for Group channels, purple for Aux channels and blue-green for Matrix channels.

By default, the Input Channels will be assigned to Layer 1 on the left and right sections of the console. Output channels (Groups,
Auxes and Matrices) and Control Groups will be assigned to the centre section. These bank assignments can be customised by
the user and saved in a session at any time.
Holding any bank or layer button down for a couple of seconds will switch all 3 worksurface sections to the same bank level or
layer.
The controls on each different type of output channel are similar but an input channel has a number of additional features.
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1.4 Hardware Configuration

1.4.1 Connections ..........................................................................
Detailed information on the various systems of connection is provided in the relevant Appendix but the following diagram provides
an overview of a single console/single rack setup.

All connections should be made before switching on the console and racks.
The console and rack each have dual redundant power supplies and both should be switched on at all times. After switching on
the console the software will be launched automatically and the state of the worksurface and settings should be the same as
when it was last Shut Down.
To Shut Down the console press the System>Shut Down button and wait until you receive a message saying that it is safe to
switch the power off.

The SD10 worksurface has 8 analogue I/O and 8 AES I/O on its rear panel and remote I/O racks are available in several formats.
These racks can be connected to the console with 2x 100M high specification 75Ohm coaxial cables fitted with BNC connectors,
or optical fibre.

In normal operation the MADI connections should be as follows (see diagram below):
Rack MAIN MADI IN connected to the console MADI 1A OUT
Rack MAIN MADI OUT connected to the console MADI 1A IN

Note - Optionally, a second set of MADI cables can be connected to provide MADI redundancy from the
rack's AUX MADI ports to the console's MADI 1B ports

The console's MADI Port 2 can be connected to a MADI recorder or a second DiGiCo Rack or console.

Optional Remote Control 
Laptop connection with

Ethernet Crossover Cable

STANDARD CONNECTION WITH MADI

MAIN MADI 
IN

MAIN MADI 
OUT

MADI 1A OUT

MADI 1A

MADI INPUTS

MADI OUTPUTS

MADI 1BMADI 2AMADI 2B

MADI IN

MADI 1A IN

MADI OUT

Remote I/O Rack
AUX MADI 

IN
AUX MADI 

OUT

MADI 1B OUT MADI 1B IN

Optional
Redundant

MADI
Connection

SD10 Rear Panel MADI Connections

MADI 2A IN

MADI 2B OUT

Optional 
MADI Recorder 

or
Second I/O Rack
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1.4.2 Audio I/O Panel.....................................................................
The Audio I/O window is used to configure the physical I/O connected to the SD10, including configuring and naming the sockets
of the cards installed in racks, and the setting of Pads and phantom power.
Local I/O : The SD10 provides local audio I/O in the rear of the console. These operate independently of connected racks.
To access the SD10 Audio I/O Setup touch Setup>Audio I/O on the Master Screen
The Audio I/O window that opens is divided up into the following sections:

Port Selection 
and Status

Global Port 

Management
Configuration of 
Cards & Sockets 

or Splits & Sharing,
as defined by 

buttons to the left 

Graphic 

Representation of 
Selected Rack

Selected Port’s 
Properties

The top-left corner of the window shows the ports. Each port relates to an available physical audio connection (Local IO, MADI
Ports or optional Optocore connections).

The top section to the right of this contains the controls relating to the ports. When a port is selected, this section changes to
reflect the status of the selected port, and allows it’s configuration to be changed as required.

Below the port controls is a graphical representation of the rack configuration connected to the selected port. Depending on the
port selected, the graphic will change, showing the available physical I/O. Each small “square” on the image represents a single
physical audio connection or socket, with these arranged in columns or rows, representing I/O cards in racks, or the local I/O on
the back of the console.

The section below the graphical rack picture displays one of three things, as selected by the coloured buttons to its left:
- Select Cards &Sockets to configure the cards or slots and sockets, including

custom naming, phantom power and pad selection.

- Select Splits &Sharing to configure the sharing of card control between
consoles and split outputs on an SD Rack

- Select Setup Optocore to configure optocore connections (See SD Software Reference Manual Appendix - DiGiCo
Optocore V221 - For SD Rack Optocore Operation)

The local I/O configuration is fixed, so no hardware changes are possible. You can, however, change the Port Name, the Group
Names and the Socket Names (the name of each physical connector on a card).

Note that Setup Optocore only applies (and only appears) if the session is setup to use Optocore version 221.
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1.4.3 Opto V220 (DiGiRacks) and Opto V221 (SD Racks) .............
SD Series consoles can operate with either one of two different Optocore firmware versions - V220 and V221.
V220  is compatible with DiGiRacks and MiNiRacks and cannot be used with SD Racks or DRacks.
V221 is compatible with SD Racks, SD MiNiRacks, NaNoRacks and DRacks, and cannot be used with DiGiRacks and MiNiRacks.
Note: Any type of rack can be used with an SD Series console if it is connected with Coaxial BNC MADI irrespective
of the Optocore version that the console is using.
Sessions that have been created using Optocore connected DiGiRacks and MiNiRacks can be used with SD Racks and DRacks
but a procedure must be followed to achieve this.
Sessions created using Optocore connected SD Racks and DRacks can also be used with DiGiRacks and MiNiRacks but this also
involves a “conversion” procedure.

Note: For detailed information on Optocore system setup please refer to the SD Software Reference manual
Appendix - DiGiCo Optocore V221 - For SD Rack Optocore Operation

1.4.4 Single SD Console System ..................................................
On an SD10, go to Setup/Audio I/O.  Press the Setup Optocore button and the Single Console button will be shown with a bright
red background.  Press this button, press Yes at the confirmation stage and the console will create ports for all connected racks,
allocate all output cards to your console and create the Optocore map.  The system is now ready to use.

Audio I/O Panel
Optocore Setup
Single Console

1.4.5 Rack Connections .................................................................
With a Rack selected in the left hand port selection list, the window will change to look something like the image below, depending
on the cards installed in the connected rack. The graphic shows the 14 available cards/slots, 7 input & 7 output.

Edit the Port Name here. 
Eg. Stage Rack, Local Rack etc...

Select Card Type manually or 
using Auto-Conform function, 

and edit Group Name

Selected Socket Properties
Edit Name and  Socket options.

Auto Conforming for all ports, 
individual racks, 
or individual cards

Select the contents of the bottom-right 
corner of the Audio IO window

Select the port to be configured Copy Rack Audio to MADI

In order to use the rack, the on-screen contents of the rack must match the cards physically installed in the rack connected. There
are two ways of achieving this :
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Manual Conforming of Rack:
Select each card (column) and manually select the appropriate card in the Card/Slot Type drop down menu in the lower section of
the window (displayed when the Cards & Sockets button towards the bottom-left is selected). Once the correct card type is
selected, the Label at the bottom the selected card will turn green, indicating the card type matches the card installed in the rack. If
the Card Type name is Red, then there is a mismatch, and the error should be corrected by selecting the correct card type.

Automatic Conforming:
There are three levels of automatic conforming:
- globally, using the red Conform All Ports button in the bottom left of the window;

- on a rack-by-rack  basis, using the conform rack button just below the rack view
section of the window;

- on a card-by-card basis, by selecting a socket from the card in the graphical display
and using the conform card button next to the Card/Slot type button selector in the
lower section of the window. (Note that the Cards & Sockets button towards the
bottom-left should be selected)

Pressing any of these buttons will correctly select the card types for the range in question. Once complete, all of the Card Labels
beneath each slot should turn green.

Copying Audio and Listening to Copied Audio (MADI Recorder Setup)
Audio from a Rack can be copied to the MADI Port Output by selecting the incoming Port in the Ports list and using the Copy Audio
To drop down menu. For example, if you want to copy the Rack Audio Inputs to a recorder connected over MADI, select Rack 1
in the ports list and then select MADI from the Copy Audio To drop down menu. The 56 inputs on Rack 1 will be copied to the
SD10 MADI output.

In addition, by connecting the recorder's MADI Output to the SD10 MADI Input, the playback can be monitored in the same channels
as the original source material. Just press the Listen To Copied Audio button to monitor playback and press it again to return to
monitoring the live sources from the rack.

Standard MADI Connections
If you have a standard MADI connection (not a DiGiCo Rack) to your SD10, you can set the console to display the MADI with
generic signal names, i.e. MADI 1, MADI 2.. etc. through to MADI 56 (or 64) instead of the usual rack style names. The naming does
not affect the signal, but makes routing signals easier.

Unrouting All Outputs
All outputs to the selected port can be unrouted at once by pressing the unroute all outputs button below the cards graphic
and selecting yes in the warning pop-up which appears. "Copied" audio is not unrouted by this action.

Note that this will cancel all routing created in the channel screens and cannot be undone.

Console to Console routing
If two DiGiCo consoles are connected together, it is possible to route audio between them.

1.4.6 Rack Sharing.........................................................................
In a multi-console system where Racks are connected with MADI and shared between two DiGiCo Consoles, only one of the
consoles can take control of the rack, with respect to Gain, Phantom Power and Pads. To overcome this, it is possible to place the
SD10 into one of 3 states of operation:
Isolate : The SD10 will not communicate with the rack and therefore any adjustment of input gain or +48V switch will have no
effect on the rack settings
Receive Only : The SD10 will receive the rack’s existing settings but will not be able to control the gain etc on the racks.
Full Control : The SD10 will send its settings to the racks and change them accordingly.

Sharing is configured in the Rack Sharing area, found in bottom right-hand corner of the window when the Splits & Sharing
button is selected:

These three states can be set on a per-rack basis (right column), or globally for all shared racks (left column).
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1.5 Configuring a Session
The SD10 has a default setup which means that the new user need not get involved in configuring the desk at this stage. How-
ever, here is a brief overview of how the different displays are used in putting together a session. Each of the master displays
introduced below are described fully within the rest of the manual.

The Setup > Audio IO display is used to configure the physical I/O connected to the SD10, including configuring and naming the
sockets of the option cards installed in racks, and the setting of pads and phantom power. (See previous section)

The File > Session Structure display is used for configuring how the console’s the DSP channels are divided between channel
types, and is also where the format of the channels is defined.

The Session Structure display can be used to automatically assign the channels to the worksurface. However, channels can
also be manually added to the worksurface using the Layout > Channel Faders display.

1.5.1 Session Structure ..................................................................
When starting a new session, it is important to decide how many of each type of buss is required. While changes to session
structure can be made once a session has been started, it is best to try and set these parameters before configuring the session.
The structure will set the number and type of aux and group channels and allow you to choose which parts of the new session
will be cleared and reset. There is also an option to automatically route the inputs and outputs from channel types that you have
opted to clear.
To adjust any of the channel allocations, touch on the associated channel count box, and either enter a number using the pop-up
number keypad, or adjust using the assigned touchturn controller.
The maximum total amount of Aux and Group channels available is 48. As you increase the number that you require you will see
the resources available decreasing accordingly in the number boxes at the bottom of the panel.

Note - Pressing the Default All button followed by the Restructure button will automatically configure a new
session with the following setup where the first 96 rack inputs are routed to input channels 1-96 and the
Master Buss is routed to Local outputs 1 & 2 and also to rack outputs 1 & 2. All input channels will be routed
to the Master Buss and the console headphones will be fed by the Master Buss when nothing else is soloed.

The default configuration is :
96 Input channels (Adjustable)
6 Mono Aux busses & 6 Stereo Aux busses (Adjustable)
6 Mono Group  busses & 6 Stereo Group busses (Adjustable)
16 Matrix Inputs and 16 Matrix Outputs (Fixed)
24 Control Groups (Fixed)
1 Stereo or LCR Master Buss (Fixed)
2 Mono or Stereo Solo Busses (Fixed)

Total number 
of unallocated 

processing 

Option to Clear
parts of the session
when restucturing

Option to route automatically
inputs/outputs when

using the Clear function

Total number 

Create a default session
with flat parameters 
and basic routing 

of spare 
busses 

Touch number’s to 
edit with pop-up 

keypad or touchturn 

Set number and type of Aux 

Set number and type of Group 

Set Order of Aux and 
Group busses

Enter Session title

Select session 
sample rate
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Clear All Buttons: When changing routing, you have the option of clearing any non-default routing or processing (EQ, dynamics
etc) from the channels in the session. This is especially useful when restructuring an existing session to make a new session.
The clear snapshots, clear automation and clear macro’s perform similar operations.
Rebuild Banks: When changing the session structure, there are two possible scenarios. If you restructure the session without
rebuilding banks, any additional channels you have allocated are not “placed” on the worksurface, and need to be manually
assigned to faders.  If however, you restructure a session with Rebuild Banks enabled, the worksurface will be built with all
channels available on the worksurface.
Aux Sends and Direct Sends: By toggling the state of the Aux Sends and Direct Sends Buttons in the Input Channels section, it
is possible to change the default operation of the Aux Sends and Direct Sends. These functions toggle between “Post Fader”,
“Pre-Fader” and “Pre-Mute”. These buttons can only be used in conjunction with the clear all function.
Auto-Route: The Auto-route functions automatically routes consecutive inputs for input channels, and consecutive outputs for
busses. For example, auto-routing 60 inputs will route the first physical input (eg 1:Mic 1) to input channel 1, the second physical
input (1:Mic 2) to input channel 2…  until you either run out of inputs or channels. Auto-routes are as follows :
Input Channels auto-route with physical inputs
Aux, Group and Matrix Channels auto route to physical outputs
Matrix Inputs auto-route with group outputs
NOTE: Auto-Routing can only be used in conjunction with the “Clear All” button.
Session Sample Rate: The Session Structure window is also used to set the session's sample rate. Use the buttons to the right
of the session title box to switch the sample rate between 48kHz and 96kHz.

1.5.2 Assigning Faders to the Worksurface .................................
If, after a Session Restructure where the Rebuild Banks button was not pressed, you find that newly created channels do not
appear on the worksurface, open the Layout>Channel List panel on the Master screen and you will see a full list of all input and
output channels that are present in the session.
Channels can be assigned to the worksurface individually (in order to create custom banks of mixed channel formats) or as
complete banks.
First, select a bank and press the LCD Function button.
To create a custom bank, press the Channel Select button below the display labelled Assign Faders followed by the LCD button
on the fader to be assigned (or select multiple faders to assign consecutive channels).
To create complete a complete bank, press the Channel Select button labelled Copy Bank From.
Having selected the faders or bank, press the first channel that you wish to assign on the Layout/Channel List on the Master
screen.
Consecutive channels will be assigned to the selected worksurface faders.
Now press the LCD Function button again and return to the standard mode by pressing the LCD button labelled Solo

Touch first channel 
to assign

Press LCD Function button
then Assign Faders

Press LCD button(s)
for Assignment

Open 
Layout/Channel Faders

Click down arrow 
to expand list
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1.6 Saving and Loading Sessions
1.6.1 Save As New File .................................................................
When you change the configuration of the a session you should save under a new filename.
If the Save Session panel has not appeared automatically after a session restructure then touch the Files button on the Master
screen and then press Save As New File.
Select the destination drive (Internal or Removable) and file path and then enter a new file name and description for the file - then
press the Save button.
The USB connection for the removable drive is located in the top right hand corner of the centre section.

Note: If you touch a session name on the existing list, this name will automatically be selected as the new file
name and touching Save will overwrite the old file.

Enter a Filename Enter a Description

Internal files saved 
in D:\Projects

Select Internal or 
Removable USB

To create a new folder
in D:\Projects

1.6.2 Save Session ........................................................................
This button which is found above the Save As New File button will save the existing session in the same location and under the
same file name as it was previously saved or loaded from. It therefore serves as a "Quick Save" option to update an existing
session.
Remember that this function will overwrite your last saved version.
If you wish to save the session under a new name use the Files menu button and select Save As New File (See above).

Load Session
To load a previously saved session:
Touch the Files button on the Master screen and then press Load Session.
Select the source drive (Internal or Removable) and the required file from the list - then press the Load button.

Select a File File Details

Internal files saved 
in D:\Projects

Select Internal or 
Removable USB

Press Load
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1.7 Audio Sync
The SD10 will operate at Sample Rates of either 48000Hz (48kHz) or 96000Hz (96kHz). By default, it is set to clock internally (as a
Master) at 48kHz. To switch the clock to 96kHz, open the Session Structure dialogue in the File menu and click on the appropri-
ate sample rate button at the top of the window.
Within a normal setup, the SD10 will usually remain as clock master. However, there are times when the SD10 needs to be
clocked externally.  The Audio Sync panel allows you to control external synchronisation.
To access the Audio Sync Panel, touch the Setup Menu button, followed by Audio Sync. A panel similar to the below will open.

The SD10 will clock from the following sources : Word Clock, AES/EBU, MADI & Optocore (if fitted)
Note : When a valid clock is detected on an external sync input, the corresponding Green OK box will light, even if that input is not
selected as the clock source for the SD10.

Example External Clocking : Word Clock @ 48kHz
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1.8 Routing Basics

1.8.1 Selecting Inputs & Outputs ...................................................
All channel input, output, insert send and insert return routing is done via routing displays, accessed via the dark grey routing
buttons in the channel Setup and Output displays (shown below for an Input channel’s input).

Note that multi-channel signals are routed individually, and then collected together as a "Multi Channel" as
described in the SD Software Reference manual

To access Channel Input Setup, touch the top of an input channel display on the touchscreen.
To access Channel Output Setup, touch the bottom of any channel type's display on the touchscreen.

Press Main Input

Label Channel

Mono/Stereo

Touch top of
Input Channel

Select or type
Number of Inputs 
to Ripple Route

Select
Card Select

Socket

Select
Rack

Select a Layer

Select a Bank

Within each display, there are three columns containing three levels of routing selection:

- The left-hand column contains the available ports within which the desired input or output might be located;
- The middle column, signal groups, then shows the available groups of inputs or outputs within that port;
- The right-hand column, signals, then displays the individual inputs or outputs available within that signal group.

The boxes in each column are lit blue to indicate that they are currently selected. If there is already a routing assigned within the
display, the port and signal group columns containing the current assignment will be half-lit.

Each output can only have one channel routed to it. The outputs that are currently in use by another channel display in blue text. If
you attempt to route a different channel to an output which is already in use, a confirmation box appears, indicating which channel
is already using it, and warning that continuing with the action will cause the old channel to be derouted from this output. Press
Yes to proceed, No to cancel.

Note that when routing direct outs from Input channels or outputs from output channels, any number of
available signals can be selected. A new route selection will therefore be added to previous selections in
these cases. However, inputs, insert sends and insert returns can only route to/from one signal (in the case of
mono channels) or two signals (in the case of stereo channels). A new route selection will therefore result in
the previous selection being lost for inputs and insert sends and returns.

For stereo channels, left and right routes are presumed to be consecutive: When routing stereo signals, select the left route, and
the next signal in the list will be automatically selected as the right route. If the last signal in a signal group or port is selected as
the left route, the first signal in the following signal group or port will selected as the right route.

Note: If Waves is enabled, a Waves port will be displayed. See the relevant appendix for more details.
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For input and insert return routing, the INTERNAL port provides the following signal groups:

Misc: The oscillator, white and pink noise generators.
Graphic EQs: The outputs of the SD10’s internal graphic EQ’s.
Effects: The outputs of any effects sends that have been created
Channels: The direct outputs from the other input channels
Groups: The outputs of the group busses
Auxes: The outputs of the auxiliary busses.

Note: The outputs for the channel being routed are locked out of the signal list.

Note also that the console views all routes as a single list. Therefore, if the left signal is connected to the last
signal in a port, the right signal, will be automatically connected to the first signal of the next port, regard-
less of port type.

For output and insert send routing, the INTERNAL port provides access to the inputs of the SD10’s Graphic EQ’s, and the inputs to
any effects that have been created.
The 0:Local I/O port contains a list of the inputs or outputs found directly on the SD10’s back panel.
The Rack ports contain all of the inputs or outputs available within the remote I/O racks, as defined in the Audio I/O display.
The mono > mono and mono > stereo buttons define whether sends from mono channels to the console's Internal effects and
Waves effects (see the relevant appendix) are mono or stereo.

Once a route has been selected, its name will appear below the routing button in the Setup or Outputs display.
Whenever a route is created, metering and additional controls are made available below the routing button. These controls are
dependent on the type of route created.

Local input routed to an input or insert return: a Line or Mic selector.
Line input routed to an input or insert return: no additional control.
Mic pre-amp routed to a mono input: a 48V button for remote control of phantom power, and delay controls.
Mic pre-amp routed to a stereo input: a 48V button, delay controls and pan controls.
Mic pre-amp routed to an insert return: a 48V button, phase reverse (Æ) button and gain trim.
Output routed to a console output: a -10db pad (rack out only), on button for switching the send on and off, gain trim

and send point selector which toggles the place within the channel from which the
direct output is fed:

pre-F Pre-fader,
post Post-fader
pre-M Pre-mute (and pre-fader)

Insert send routed to a console output: a -10db pad (rack out only), on button for switching the send on and off, and gain
trim.

Insert send routed to a graphic EQ: an on button for switching the send on and off
Output routed to a graphic EQ: no additional control.

Buttons become ringed in either red or green to indicate that they are on.

1.8.2 Ripple Channels ...................................................................
The ripple channels function, located at the top of the route display, allows consecutive channel routes to follow the routing of
the current display incrementally. For example, Channels 1 to 8 direct outputs can be routed to Rack 1 > Line outs 1 to 8 respec-
tively by routing Channel 1’s direct out to Rack 1 > Line out 1 and allowing the ripple channels function to route Channels 2-8
automatically.

The number of channels to be rippled is defined either by selecting the appropriate grey numbered button, or by selecting the
keyboard button to the right of the numbered buttons, typing the required number of channels (8 in the example above) into the
numeric keypad which appears, and pressing OK. Once you have configured the ripple channels function, any routing action
will also effect the appropriate number of channels above the channel being routed.

The ripple channels function treats stereo channels as two channels. In other words, if Channel 2 in the above example is
stereo, the ripple channels function will route Channel 1 to Line out 1, Channel 2 Left and Right to Line outs 2 and 3, Channel 3
to Line out 4 etc.

1.8.3 Channel Names.....................................................................
The black and white text box in the Setup display is used for naming the channel. Channel names are displayed in the scribble
strip at the bottom of the screen. By default, the channel is given the same name as the selected input signal.
Note that if no input signal is selected, the scribble strip simply displays the channel number, prefixed by ch for Input channels,
and prefixed by Aux, Grp or Matrix in the case of output channels.
The following notes are specific to naming channels:
The Next button moves the entire Setup display to the next channel.
At the very top of the channel, the channel number and input signal name are displayed for Input channels, and the channel type
and number are displayed for output channels. These labels remain unchanged, regardless of any channel naming.
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For Input channels, note that if the channel input signal is changed once a channel has been manually
named, the channel name will no longer follow the input signal name. To reactivate the automatic channel
naming function, clear the name and re-select the channel input.
Note also that the channel Output display also provides access to this channel naming facility.

Channels can also be named directly in the Channel List display (in the Layout menu). Open the display, activate the Edit
function below the list, and expand the required channel type list by touching its row. Touching the channel name column for
any channel in the list will cause a keyboard pop-up to appear, where a name can be typed in the usual way.

1.9 Channel Processing

1.9.1 EQ ..........................................................................................
On input channels, the EQ section comprises four user-configurable parametric filters and a pair of swept High-pass and Low-
pass filters. On output channels, there are eight bands of EQ and no filters.
The EQ is accessed by touching the on screen display to Assign the channel (the colour changes to yellow) and then using
the controls on the right hand side of the screen.
When a control is adjusted the expanded view seen below appears in the input screen but this view can be seen at any time by
touching the EQ response graph on the screen.

Note - If the expanded view does not appear when a control is adjusted open the Options panel and set the
Auto Expand EQ option to Yes

Touching the normal EQ response graph will show an expanded view in a separate panel.
The order of EQ and Dynamics in the channel signal path can be changed using the worksurface button to the right of the
worksurface HPF and LPF controls.

EQ Presets Copy EQ Settings

EQ Type

HPF/LPF

4 Bands

Dynamic EQ

The type of filter used by the top and bottom bands can be changed by successive presses of the Curve button for that band.

Dynamics are available to each EQ band – dynamic EQ modules can be assigned to a maximum of 16 channels. Clicking on the
'delta' EQ button below the band's gain control will open up its Dynamic EQ display:
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1.9.2  Dynamics ..............................................................................
The dynamics are accessed by touching the words Comp or Gate just below the EQ graph on screen to open the dynamics
panel.
There are two dynamics modules, the first of which can function as a simple compressor, a 3 way multiband compressor, or a
de-esser, according to the comp/multi/desser button to its left. The second (lower) module can function as a gate, a ducker or
a compressor with an external sidechain, according to the gate/duck/comp button to its left.
The worksurface controls beneath the screen control the various parameters. Touching the Close button in the top right corner
of the panel will close it.
Multiband Compression is available for up to 10 channel dynamics modules. Click on the multi-band button at the top of the
display to access the 3 dymanics bands:
Dedicated Threshold, Gain controls and In/Out switches can be found on the right hand side of that section's worksurface.
These can control the Assigned channel's dynamics whether the on screen dynamics panel is open or not.

Dynamics Presets

The Assignable encoders and switches beneath the screen can be assigned to any of the main dynamics controls. Hold the
Assign Switch button on the left of the input section and touch the dynamics control required on the screen. The selected
control is shown by the Status Display.
Multiband Compression is available for up to 16 channel dynamics modules. Click on the dynamics mode select button on the
left of the display to access the 3 dynamics bands

Each band includes all of the parameters as those found in the single band compressor. The link function remains available for the
whole compressor, and is not assigned to any band. The bands can be switched on individually using the on buttons in the left-
hand side of each band, or together using the all on button to the display’s right.

The crossover frequency between bands is controlled using the purple and red pots to the left of the hi and lo bands. Each
crossover has a range of 20Hz to 20kHz, and the crossover frequencies are displayed below each pot. Each band can be
auditioned by pressing the listen button below each gain pot which solo’s that band to the mix (not the solo buss), in effect
temporarily switching off the other bands.
Pressing multi-band again returns the compressor to single-band.

The channel strip’s compressor threshold and gain controls adjustment all three bands’ controls, maintaining any relative offsets.
The individual controls are mapped to the assignable rotaries below the screen.

Note: Beyond the link function, the single and multi-band compressors have completely separate settings: No settings are copied
between them, and the settings of each remain unchanged when the other is active.
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1.9.3 Auxiliaries .............................................................................
The auxiliaries can be accessed by touching the auxiliary row on screen or using the Screen Scroll buttons on the left of the
worksurface
Using either of these methods, the highlighted auxiliaries on the input screen will change. The 3 rows of rotary controls and
switches in each worksurface section are used as auxiliary sends, pans (with 2nd Function ON), On/Off and pre/post switches
(with 2nd Function ON).

Assigned
Control LCD

Hold then
touch screen
to Assign

Assignable Aux Send Controls
Touch screen to select

It is also possible to show all of the aux sends for a channel in a single display and assign them to the 24 rotaries beneath the
screen. This is done by touching the currently assigned aux row on the screen for the channel that you want to display. The
layout of the display indicates which encoder each aux is assigned to; if there are more that 24 sends, the assignments becomes
scrollable using the Screen Scroll function.

Once you have adjusted the auxes in this display, you need to close it manually before opening any other channel detail display.
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1.10 The Matrix
To open the Matrix Inputs panel, touch the Matrix button on the Master Screen Menu.  The window that opens allows you to route
inputs to the Matrix Output Channels, and set the Matrix crosspoint levels.
To route an input, touch the top of the appropriate Matrix column. This opens a standard SD10 input routing page.

Matrix Input Routing  

Matrix Crosspoint

Level Control

 

Matrix Snapshot 

Safe control

 

Matrix Preset Control Touch-turn assignments

The example above has the Master Stereo Buss routed to the inputs of Matrix 1 and Matrix 2 (Labelled as PA LEFT & PA RIGHT).
By adjusting the crosspoint levels, you can change how much of each side of the Master buss is fed to these Matrix Channels.

There are three modes of level adjustment : multi, single & all.
Multi : Touch one or more level “knob” on screen, then adjust using the Touchturn control.
Single : Touch any level “knob” and adjust. Touching another “knob” will deselect the first.
All : All “knobs” are adjusted at the same time.
When adjusting more than one crosspoint, their relative levels are maintained.

Note that Matrix outputs are named in the Matrix Channel displays.
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1.11 Control Groups
Any number of input channels and output channels can be connected to one or more of the 24 Control Groups. They can then all
be operated from a single worksurface channel.  Changes to the Control Group fader, mute or solo or controls will affect all
channels connected to the group.

There are 2 methods to set up Control Groups:

1) Press the LCD Function button on a CG fader bank (normally found in the centre section)
Press the JOIN CG button
Press the channel select button for the CG that you want to use
Press the channel select buttons for each of the channels that you want to make members of the CG
Release the JOIN CG button and return to standard Solo mode by pressing the channel select button beneath the LCD display
labelled SOLO

Press LCD 

Function Button 

then JOIN CG

Select Control 

Group to join

Press Channel LCD Buttons to assign members

2) Press the on screen JOIN/LEAVE button for the required CG channel
Press the channel select buttons for each of the channels that you want to make members of the CG
Release the JOIN/LEAVE button

List of members

Press Join/Leave button on required CG channel Press Channel LCD buttons to assign members

A list of all the connected channels and their names is displayed above each Control Group display.

You can also clear all the channels from a Control Group by pressing Clear.

When a channel is a member of a Control Group, its own controls can still be adjusted independently of the other Group members.
Adjustments to fader levels are transmitted to the Group members as dB changes, so that a level increase of 2dB on the Control
Group fader will increase all the member levels by 2dB, irrespective of the relative levels of the individual channel faders.

Control Group Mutes are treated as “in series” where a channel is a member of more than one group – all CG mutes must be off
for channel to be unmuted and muting any CG always mutes all of its members. If a channel is CG muted by single or multiple CGs,
the worksurface channel mute button will override all CG mutes for that channel. The channel will not however be removed from
CG membership, so if the relevant CG is muted again, the channel will also be muted.
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1.12 Solo Setup
The SD10 Solo panel is accessed from a button at the top of the Master Screen. Some of the controls on this panel are duplicated
on the right worksurface section.

There are two solo busses and each channel on the console can be independently assigned to use Solo1, Solo2 or Solo 1+2.
Therefore, if the console was being used for Stage monitors, the first solo buss could feed “In-Ear” monitors, and the second solo
buss could feed a wedge.

Solo Trim

Solo Delay

Activate Floating Meters

Direct Out Level - Fader Assignment

Direct Out Level

Solo Level

Mono / Stereo switch

No solo source select

 Insert routing

Direct Out routing

Headphones On / Off

Clear

multi / single solo mode

pfl / afl solo mode

The following functions are available independently for each solo buss :

- Mono / Stereo Switch
- No Solo source routing
- Insert Point with both internal and external routing capability
- Direct Out routing (eg. for feeding a wedge)
- Assignment of Direct Out level control to master fader or speaker volume pot
- afl or pfl mode
- single or multi solo mode
- Delay
- Level Trim
- Auto solo mode
- Solo meters can be displayed on the Master or Overview screen by pressing the floating meters button below the solo delay
area in either side of the Solo panel.

No Solo : Source for solo buss when no channel is in solo mode. No Solo source does not show on Solo meters.

Auto Solo : If a channel is set to Auto Solo, it will automatically solo when another channel is soloed. The Auto Solo function of
each solo buss can be enabled and disabled as required. The solo buss must be in multi mode for the auto solo function to
operate.
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